
DataView Tab

The DataView tab provides a graphical environment for creating, viewing, and editing those files 
residing on a remote database server as part of a database project. The DataView tab is your starting
point for managing your data source connections and the objects related to them such as database 
diagrams, tables, views, and stored procedures.

Within each data source  in a database project 

, the DataView tab displays the following types of files in separate folders:
Icon Folder name For more information 

Database Diagrams See the “Database Designer Overview” topic in
the Database Designer book in the InfoView 
tab.

Table See the“Tables Overview” topic in the 
Database Designer book in the InfoView tab.
Within a table, you can also see a list of 
columns  and triggers . For information 
about columns, see the“Column Properties 
Overview” topic in the Database Designer book
in the InfoView tab. For information about 
triggers, see SQL Server Books Online.

View See SQL Server Books Online.
Within a view, you can also see a list of 



columns .
Stored Procedures See SQL Server Books Online.

Within a stored procedure, you can also see a 
list of parameters .

The DataView tab is visible when your database project is connected to a data source. For more 
information about the database objects you can manage in the DataView tab, see the Microsoft 
Visual DataTools in the MSDN books online.



Database Project Icon 

Identifies the name of your database project. This is the root node for all files in the FileView tab and 
DataView tab of the project workspace.

In the FileView tab, you can expand this node to show all the connections to data sources and to 
local database items, or queries, referenced in those data sources.

In the DataView tab, you can expand this node to show all the data sources that your database 
project is connected to.

You can also right-click this node to open a shortcut menu.



Database Icon 

Identifies, by name and database server, the data source that your database project is connected to. 
This represents the root node of a data source, usually a database.

You can expand this node to show the types of database objects stored in the database on the server.
You can also right-click this node to open a shortcut menu.



Database Diagram Icon 

Identifies the name of your database diagram. Database diagrams enable you to create, view, and 
edit database tables and the relationships between them. You can:

· Expand this node to show the tables that are represented in the database diagram.
· Double-click this node to open the diagram in the Database Designer.
· Right-click this node to open a shortcut menu.
· Drag this node into an open database diagram to add all of its tables to the diagram, or drag it into 

the Diagram pane of an open query.



Table Icon 

Identifies the name of a table in the database. If another user is the owner of the table, that user’s 
SQL Server login ID dispays in parentheses after the table name. You can:

· Expand this node to show the names of the columns in the table.
· Double-click this node to show the table data in the Results pane of the Query Designer.
· Right-click this node to open a shortcut menu.
· Drag this node into an open database diagram to add the table to a diagram, or drag it into the 

Diagram pane of an open query.



Column Icon 

Identifies the name of a column in the table. You can:

· Right-click this node to open a shortcut menu.
· Drag this node into an open database diagram to add the table to a diagram, or drag it into the 

Diagram pane of an open query to add the column to your query output.



Trigger Icon 

Identifies the name of a trigger attached to the table. You can:

· Double-click this node to open the trigger in a text editor.
· Right-click this node to open a shortcut menu.



View Icon 

Identifies the name of a view in the database. A view is a “virtual table” that provides an alternative 
way of looking at data from one or more tables in the database. It is created as a subset of columns 
from one or more tables, and its definition is stored in the database. If another user is the owner of the
view, that user’s SQL Server login ID dispays in parentheses after the view name. You can:

· Expand this node to show the names of the columns in the view.
· Double-click this node to show the table data in the Results pane of the Query Designer.
· Right-click this node to open a shortcut menu.
· Drag this node into the Diagram pane of an open query.



Stored Procedure Icon 

Identifies the name of a stored procedure in the database. A stored procedure is a precompiled 
collection of Transact-SQL statements and optional control-of-flow statements stored in the database 
and processed as a unit. If another user is the owner of the stored procedure, that user’s SQL Server 
login ID dispays in parentheses after the stored procedure name. You can:

· Expand this node to show the names of the parameters in the stored procedure.
· Double-click this node to open the stored procedure in a text editor.
· Right-click this node to open a shortcut menu.



Parameter Icon 

Identifies the name of a parameter in the stored procedure. You can right-click this node to open a 
shortcut menu.



Data Source Icon 

Identifies, by name and database server, the data source that your database project is connected to. 
This represents the root node of a data source, usually a database.

You can expand this node to show all the local database objects associated with the data source. You
can also right-click this node to open a shortcut menu.



Query Icon 

Identifies the name of a query stored as a file with a .dtq extension in the project. 

You can double-click this node to open the query in the Query Designer. You can also right-click this 
node to open a shortcut menu.



Insert Database Item Dialog Box

Allows you to select database items and insert them into the current data source or project. This 
dialog box appears when you choose Database Item from the Insert menu.

Dialog Box Options
Database Item      Lists the types of objects available in the databases you are connected to and lets 

you select the type of database item you want to insert:
Database 
Item

Microsoft 
SQL Server 6.5

Microsoft 
SQL Server 6.0

Oracle 7.x All Others

Table available not available not available not available
Database 
Diagram

available not available not available not available

Query project 
dependent

project 
dependent

project 
dependent

project 
dependent

Stored 
Procedure

available available available not available

Database      Lists the databases you are connected to for this project. Select the database that you 
want to insert the data item into.

OK      Creates the database item you selected in the appropriate editor.
Cancel      Cancels this action.
Help      Opens the Help topic for this dialog box.



Options Dialog Box

Allows you to set options for queries and stored procedures for Microsoft SQL Server databases. This
dialog box appears when you choose Options from the Tools menu. In the dialog box, choose the 
DataView tab to set the options described below.

Dialog Box Options
Limit SQL output      If checked, this option limits the number of lines of data visible in the debug 

window when you run a query or stored procedure. If you check this option, type the number of 
lines you want to be able to see in the SQL pane.

SQL Query Timeout      The number of seconds that elapse before a database connection times out. 
The default is 15 seconds.

SQL Server debugging      If checked, this option enables the SQL Server debugger. 
Verbose SQL output      If checked, this option causes all output from the SQL Server driver to be 

displayed in the Debug tab of the Output window during debugging. 
OK      Accepts your settings.
Cancel      Cancels this action.



Create Trigger dialog box

Allows you to specify the types of transactions that will activate the trigger you are creating. Triggers 
are often created to enforce referential integrity or consistency among logically related data in 
different tables

Dialog Box Options
Name      Shows the default name of this trigger. You should type a different name for the trigger when

you create it.
Insert      If checked, this option activates the trigger when you add data (using the INSERT statement)

to the table.
Delete      If checked, this option activates the trigger when you delete data (using the DELETE 

statement) from the table.
Update      If checked, this option activates the trigger when you change data (using the UPDATE 

statement) in the table.
OK      Accepts your settings.
Cancel      Cancels this action.
Help      Opens the Help topic for this dialog box.



Execute Permissions Dialog Box

Under construction.



Execute Stored Procedure Dialog Box

Under construction.



Server Error(s) Dialog Box

Under construction.



Zoom Dialog Box

Under construction.



Save As Dialog Box

Under construction.



Choose Name Dialog Box

Under construction.



Save Change Script Dialog Box

Displays a change script whenever there are unsaved database changes in your table or database 
diagram and enables you to save the change script as a text file with an .sql extension in the project 
directory. This dialog box appears when you choose Save Change Script from the File menu or click 

the Save Change Script button  on the toolbar.

Dialog Box Options
Yes      Saves the SQL change script in the project directory.
No      Cancels the save action.
For more information about saving SQL change scripts, see the topic “Saving a Change Script.”



Datatype Change Required Dialog Box

Appears when you change the data type, length, scale, or precision of a column that participates in a 
relationship.

Dialog Box Options
Yes      Changes the data type properties of the related columns shown in the list so that existing 

relationships are preserved.
No      Cancels the data type change and restores the previous data type to the column you just 

changed.
Note      Although you cannot undo changes made to a table or database diagram, the changes are 
not saved to the database until you save the table or diagram. You can discard any unsaved changes 
by closing all open diagrams without saving them.
For more information about changing data types, see the topic “Changing the Data Type Assigned to 
a Column.”



Save Dialog Box

Appears when you attempt to save a database diagram or selected tables in order to confirm the 
tables that will be saved. This dialog box does not appear when your diagram contains only one 
modified table.

Dialog Box Options
Yes      Saves all the tables shown in the list.
No      Cancels the save action.
Save Text File      Saves the list of tables in a text file in the project directory and displays a message 

box with the fully-qualified filename of the text file. This file provides a record of the tables that were
affected by the changes you made.

Note      Although you cannot undo changes made to a table or database diagram, the changes are 
not saved to the database until you save the table or diagram. You can discard any unsaved changes 
by closing all open diagrams without saving them.
For more information about the effects of saving tables and diagrams, see the topic “Saving Database
Changes.”



Database Changes Detected Dialog Box

Appears if you attempt to save a database diagram or selected tables and some of the database 
objects that will be affected by the save action are out of date with the database. Accepting the 
changes shown in this dialog box updates the database to match your diagram and overwrites other 
users’ changes.

Dialog Box Options
Yes      Updates the database with all the changes shown in the list.
No      Cancels the save action.
Save Text File      Saves the list of database changes in a text file in the project directory and displays 

a message box with the fully-qualified filename of the text file. This file provides a record of the 
changes you made.

Note      Although you cannot undo changes made to a table or database diagram, the changes are 
not saved to the database until you save the table or diagram. You can discard any unsaved changes 
by closing all open diagrams without saving them.
For more information about saving database objects that have changed since you began working in 
the Database Designer, see the topic “Saving Changes to a Modified Database.”



Unsaved Changes Exist Dialog Box

Appears if you attempt to close the last table or database diagram in the Database Designer when 
there are unsaved tables in memory.

Dialog Box Options
Yes      Saves all the tables shown in the list.
No      Closes the diagram without saving the changes.
Save Text File      Saves the list of unsaved tables in a text file in the project directory and displays a 

message box with the fully-qualified filename of the text file. This file provides a record of the tables
that were affected by the changes you made.

Note      Although you cannot undo changes made to a table or database diagram, the changes are 
not saved to the database until you save the table or diagram. You can discard any unsaved changes 
by closing all open diagrams without saving them.
For more information about canceling unsaved changes that exist in memory, see the topic “Rolling 
Back Unsaved Database Changes.”



Save Incomplete Dialog Box

Appears when errors have been encountered while you were trying to save a database diagram or 
selected tables. This dialog box lists the following: the objects that were successfully saved in the 
database, the objects that were not saved, and the errors that were encountered.

Dialog Box Options
OK      Returns to the diagram.
Save Text File      Saves the information shown in the list in a text file in the project directory and 

displays a message box with the fully-qualified filename of the text file. This file provides a record 
of the database changes that were successfully saved as well as the changes that could not be 
saved due to errors.

For more information about the errors that can occur when trying to save a diagram or selection, see 
the topic “Troubleshooting Errors.”



Create Relationship Dialog Box

Enables you to confirm the related columns and to set properties for the new relationship. This dialog 
box appears when you draw a relationship line between two tables in your database diagram.

Dialog Box Options
Relationship name      Displays the default name of the relationship and enables you to rename it.
Primary key table      Shows the name of the primary key table in the relationship, followed by the 

columns that make up the primary key. You can select different columns to match the columns 
shown under Foreign key table.

Foreign key table      Shows the name of the foreign key table in the relationship, followed by the 
columns that make up the foreign key. You can select different columns to match the columns 
shown under Primary key table.

Check existing data on creation      Applies the constraint to existing data in the foreign key table.
Enable constraint for INSERT and UPDATE      Applies the constraint when data is added to or 

updated in the foreign key table.
Enable constraint for replication      copies the constraint whenever the foreign key table is 

replicated in a different database.
OK      Creates the relationship line in your database diagram and sets the properties you selected.
Cancel      Erases the relationship line from your database diagram.
For more information about creating relationships between tables, see the topic “Creating a 
Relationship Between Tables.”



Table Property Page

This property page contains a set of properties for the tables in your database diagram and their 
check constraints.

Selected table      Shows the name of the selected table in your diagram. If more than one table is 
selected in your diagram, only the name of the first table in your selection appears. Expand the list 
to choose a different table to show properties for.

Table name      Shows the name of the selected table and enables you to rename it.
Check constraints for table and columns

· Selected constraint      Shows a list of check constraints attached to the selected table.
· New      Creates a new check constraint for the selected table.
· Delete      Deletes the selected check constraint from the database.
· Constraint expression      Shows the Transact-SQL syntax of the check constraint and enables 

you to change it. You must type a constraint expression before exiting this box.
· Constraint name      Shows the name of the selected constraint and enables you to rename it.
· Check existing data on creation      Applies the constraint to existing data in the table.
· Enable constraint for INSERT and UPDATE      Applies the constraint when data is inserted 

into or updated in the table.
· Enable constraint for replication      Applies the constraint when the table is replicated in a 

different database.



Relationship Property Page

This property page contains a set of properties for the relationships between the tables in your 
database diagram.

Selected relationship      Shows the name of the selected relationship in your diagram. If more than 
one relationship is selected in your diagram, only the name of the first relationship in your selection
appears. Expand the list to choose a different relationship to show properties for.

Relationship name      Shows the name of the selected relationship and enables you to rename it.
Primary key table      Shows the name of the primary key table in the relationship, followed by the 

columns that make up the primary key.
Foreign key table      Shows the name of the foreign key table in the relationship, followed by the 

columns that make up the foreign key.
Check existing data on creation      Applies the constraint to existing data when the relationship is 

added to the foreign key table.
Enable relationship for INSERT and UPDATE      Applies the constraint when data is inserted into or

updated in the foreign key table. Also prevents a row in the primary key table from being deleted 
when a matching row exists in the foreign key table.

Enable relationship for replication      Applies the constraint when the foreign key table is replicated 
in a different database.



Index/Keys Property Page

This property page contains a set of properties for the indexes, primary keys, and unique constraints 
attached to the tables in your database diagram. Indexes and constraints are not graphically 
represented in database diagrams.

Selected index      Shows the name of the first index for the selected table in your diagram. If more 
than one table is selected in your diagram, only the name of the first index for the first table in your 
selection appears. Expand the list to choose a different index to show properties for.

Type      Shows the object type: index, primary key, or unique.
Column name      Shows the list of columns in the index, primary key, or unique constraint. You can 

add, change, or remove column names in this list.
Index name      Shows the name of the selected index and enables you to rename it.
Create UNIQUE      Enables you to create a unique constraint or index.

· Ignore duplicate key      If you create a unique index, you can set this option to ignore duplicate 
keys.

Fill factor      Shows the fill factor. If a fill factor is not specified, the database’s default fill factor is 
used.

Create as clustered      Enables you to create a clustered index and set one of the following options:
· Sort data      Organizes the data in ascending order.
· Data already sorted      Accepts the order of existing data.
· Reorg sorted data      Reorganizes the data in ascending order. Select this option, for example, 

when the table becomes fragmented or to rebuild nonclustered indexes.
· Disallow duplicate rows      Prevents the index from being saved if duplicate rows exist.
· Ignore duplicate rows      Deletes duplicate rows from the index as it is being created.
· Allow duplicate rows      Creates the index, even though duplicate rows exist.



Database Diagram Window

The Database Diagram window presents a graphic display of the tables and relationships in your 
database.

In the Database Diagram window, you can:

· Add tables from the DataView tab:



· Remove tables from the diagram and/or delete them from the database.
· Create, edit, or delete relationships between tables:



· Create, edit, or delete database column definitions.
· Open the Properties window to edit objects shown in the diagram, or to create, edit or delete 

database objects, such as indexes and constraints, that are not graphically represented in the 
diagram:

· Lay out the objects shown in the diagram by expanding, collapsing or resizing tables, and rerouting
relationship lines:



When you save a database diagram, the database is updated to match your diagram. The diagram is 
saved in your project directory and shown in the Database Diagrams folder of the DataView tab. 
Before you save a diagram, you can view an SQL change script to see the Transact-SQL statements 
that will be applied to the database when you save the diagram. If you close a diagram without saving
it, the underlying database remains unchanged.

For more information about database diagrams, see the topic “Database Designer Overview.”



Diagram Pane
The Diagram pane presents a graphic display of the input sources (tables, views, or other queries) 
you have selected from the input source and shows any join relationships among them.

In the Diagram pane you can:

· Add or remove input sources and specify data columns for output. For details, see the section 
“Adding Input Sources” later.

· Specify columns for ordering the query.
· Specify that you want to group rows in the result set.
· Create or modify joins between input sources.

When you make a change in the Diagram pane, the Grid pane and SQL pane are updated 
immediately to reflect your change. For example, if you select a column for output in an input source 
window in the Diagram pane, the Query Designer adds the data column to the Grid pane and to the 
SQL statement in the SQL pane.

About the Diagram Pane
Each input source appears as a separate window in the Diagram pane. The icon in the title bar of 
each window indicates what type of input source the window represents, as illustrated in the following 
table.

Icon Input source type
Table
Query or View
Linked Table
Subquery (in FROM clause)
Linked View

The input source’s data columns are listed in its window. Check boxes and symbols appear next to 
the names of columns to indicate how the columns are being used in the query. ToolTips display 
information such as data type and size for columns.

The following table lists the check boxes and symbols used in input source windows.
Check box or 
Symbol

Description

            Specifies whether a data column appears in the query 
result set (Select query) or is used in an action query 
(Insert Into query or Update query). Select the column to 
add it to the results. If (All Columns) is selected, all data 
columns appear in the output. 



Note      The icon used with the check box changes 
according to whether you are creating a Select, Insert 
Into, or Update query (you cannot select individual 
columns when creating a Delete query).

    Indicates that the data column is being used to order the 
query results (is part of an ORDER BY clause). The icon 
appears as A-Z if the sort order is ascending, or Z-A if 
sort order is descending.
Indicates that the data column is being used to create a 
grouped result set (is part of a GROUP BY clause).
Indicates that the data column is part of the search 
criteria for the query (is part of a WHERE or HAVING 
clause).
Indicates that the contents of the data column are being 
summarized for output (are included in a SUM, AVG, or 
other aggregate function).

Note      The Query Designer will not display data columns for an input source if you do not have 
sufficient access rights to it or if the ODBC driver cannot return information about an input source. In 
such cases, the Query Designer displays only a title bar for the input source.

Resizing Input Source Windows
If you need more room in the Diagram pane, you can resize individual input source windows as you 
would any window. In addition, you can collapse them so that only the input source names are visible.
When you want to work with columns in an input source whose window has been collapsed, you can 
expand that input source again.

To collapse an input source window
1 Select the input source.
2 From the View menu, choose Show Table Name Only.

– Or –
Click the Minimize button in the window’s title bar.

To expand a collapsed input source window
1 Select the input source.
2 From the View menu, choose Show Column Names.

– Or –
Click the Restore button in the window’s title bar.

Working with Joined Tables
If the query involves a join, a join line is displayed between the data columns involved in the join. If 
the joined data columns are not displayed (for example, the input source window is minimized or the 
join involves an expression), the Query Designer places the join line in the title bar of the input source
window. The Query Designer displays one join line for each join condition.



The shape of the icon in the middle of the join line indicates how the input sources are joined. If the 
join clause uses an operator other than equal (=), the operator is displayed in the join line icon. The 
following table lists the icons that are displayed in the join line.

Join line icon Description
Inner join (created using equal sign)
Inner join based on “greater than” operator. (The operator 
displayed in the join line icon reflects the operator used in 
the join.)
Left outer join
Right outer join
Full outer join

Note      The words “left” and “right” do not necessarily correspond to the position of tables in the 
Diagram pane. “Left” refers to table whose name appears to the left of the keyword JOIN in the SQL 
statement, and “right” refers to the table whose name appears to the right of the JOIN keyword. If you 
move tables in the Diagram pane, you do not change which table is considered left or right.

Icons on the ends of the join line indicate the type of join. The following table lists the types of joins 
and the icons displayed on the ends of the join line.

Icon on ends of join line Description
One-to-one join

One-to-many join

Many-to-one join

Query Designer cannot determine 
join type.

See Also
Grid Pane

Results Pane

SQL Pane



Grid Pane
The Grid pane allows you to specify query options — such as which data columns to display, how to 
order the results, and what rows to select — by entering your choices into a spreadsheet-like grid. In 
the Grid pane you can specify:

· Columns to display and column name aliases.
· Expressions for calculated columns.
· The sort order for the query.
· Search criteria.
· Grouping criteria, including aggregate functions to use for summary reports.
· New values for Update queries.
· Target column names for Insert queries.

When you make changes in the Grid pane, the Diagram pane and SQL pane are immediately 
updated. Similarly, the Grid pane is updated automatically to reflect changes made in the other 
panes.

About the Grid Pane
The rows in the Grid pane display the data columns used in your query, and columns in the Grid 
pane display query options.

The specific information that appears in the Grid pane depends on the type of query you are creating.
For example, if you are creating a Select query, the Grid pane contains different columns than if you 
are creating an Update query. 

The following table lists the grid columns that can appear in the Grid pane.

Column Query Type Description
Column All Displays either the name of a data column used for the 

query or the expression for a computed column. This column
is locked so that it is always visible as you scroll horizontally.

Alias Select, Insert, 
Update

Specifies either an alternate name for a column or the name 
you can use for a computed column.

Table Select, Insert, 
Update

Specifies the name of the input source for the associated 
data column. This column is blank for computed columns.

Output Select Specifies whether a data column appears in the query 
output.
Note      If the data source allows it, you can use a data 
column for sort or search clauses without displaying it in the 
result set.

Sort Type Select, Insert Specifies that the associated data column is used to sort the
query results, and whether the sort is ascending or 
descending.



Sort Order Select, Insert Specifies the sort priority for data columns used to sort the 
result set. When you change the sort order for a data 
column, the sort order for all other columns is updated 
accordingly.

Group By Select, Insert Specifies that the associated data column is being used to 
create a grouped result set. This grid column appears only if 
you have chosen Group By from the Tools menu or have 
added a GROUP BY clause to the SQL pane. 

By default, the value of this column is set to Group By, and 
the column becomes part of the GROUP BY clause.

When you move to a cell in this column and select an 
aggregate function to apply to the associated data column, 
by default the resulting expression is added as an output 
column for the result set.

Criteria All Specifies a search condition (criterion) for the associated 
data column. Enter an operator (the default is “=”) and the 
value to search for. Enclose text values in single quotation 
marks. 

If the associated data column is part of a GROUP BY 
clause, the expression you enter is used for a HAVING 
clause. 

If you enter values for more than one cell in the Criteria grid 
column, the resulting search conditions are automatically 
linked with a logical AND. 

To specify multiple search conditions expressions for a 
single database column (for example, (fname > 'A') 
AND (fname < 'M'), add the data column to the Grid 
pane twice and enter separate values in the Criteria grid 
column for each instance of the data column.

Or … All Specifies an additional search condition expression for the 
data column, linked to previous expressions with a logical 
OR. You can add more Or … grid columns by pressing TAB 
in the rightmost Or  … column.

Append Insert Specifies the name of the target data column for the 
associated data column. When you create an Insert query, 
the Query Designer attempts to match the source to an 
appropriate target data column. If the Query Designer 
cannot choose a match, you must provide the column name.

New Value Update Specifies the value to place into the associated column. 
Enter a literal value or an expression.

Navigating in the Grid Pane
You can move from cell to cell in the Grid pane using the mouse or by pressing TAB or the arrow 
keys. As you scroll, the leftmost grid column (Column) is locked so that you can always see the data 
column name you are working with.

Resizing Grid Columns



You can resize grid columns to make more room for entries.

To resize a grid column
· Move the mouse over the divider between grid column headers until it changes to a double-headed

arrow, and then either drag the grid column header until the column is the size you want or double-
click to auto-size the column.

Editing Values in Cells
You can specify query options by entering values in the appropriate cell of the Grid pane. Certain grid
columns — for example, Column or Sort By — display a drop-down list when you navigate to them.

The check box in the Output grid column indicates whether a data column appears in the Results 
pane when you run the query. If this check box is selected, the data column will appear in the output. 
If it is not selected, the data column will be used for ordering or searching, but will not appear in the 
Results pane.

To remove an option, move to the appropriate cell, select the value, and then press DELETE. To 
remove all the values in a grid column, select the column by clicking its header, and then press 
DELETE.

Adding and Removing Data Columns in the Grid Pane
You can add and remove data columns to the grid to make them part of the query. If you are 
displaying data columns, the order in which you add them to the query determines the order they 
appear in the Results pane. Adding a data column to the query puts it rightmost in the Results pane. 
To control more precisely where a data column appears in the output, you can insert a data column 
between existing grid columns.

To add a data column to the grid
· Drag the column name from the Diagram pane onto the Column column.

– Or –
· Navigate to a blank cell at the bottom of the Columns column, and then choose the name of a 

column to add from the drop-down list.

To insert a data column in the grid
1 Select the row by clicking the box to the left of the Column column.
2 Press INSERT to insert a blank row.
3 In the Columns column, select the data column to use in the grid.

To remove a data column from the grid
· Delete the contents of the Column column for the data column you want to remove.

– Or –
· Select the row containing the column by clicking the box to the left of the Column column, and 

then press DELETE. You can select and delete multiple rows at one time.
The Query Designer removes the selected data column as an output field, sort column, and search
condition for the query.

Reordering Grid Rows
If you are displaying individual columns in the query result set, the order in which the columns appear 
in the Grid pane determines the output. The data column that is topmost in the grid appears leftmost 
in the result set, and the bottom row in the grid contains the data column that appears rightmost in the
result set.

To control where in the result set a data column appears, you can move the corresponding row in the 
Grid pane.

To reorder grid rows



1 Select the row by clicking the button to the left of the row.
2 Drag the row to the new location.

Tip      You can also insert a data column into the grid at a specific location by inserting a blank row, 
and then specifying the data column to insert. For details, see “Adding and Removing Data Columns 
in the Grid Pane” above.

See Also
Diagram Pane

Results Pane

SQL Pane



SQL Pane
The SQL pane displays the SQL statement for the current query. It is updated automatically as you 
build a query.

In the SQL pane you can:

· Create new queries by entering SQL statements.
· Modify the SQL statement created by the Query Designer based on settings you make in the 

Diagram and Grid panes.
· Enter back-end-specific statements that take advantage of features specific to the data source you 

are using.

Entering Statements in the SQL Pane
You can edit the current query directly in the SQL pane. When you move to another pane, the Query 
Designer automatically formats your statement, and then changes the Diagram and Grid panes to 
match your statement.

If your statement cannot be represented in the Diagram and Grid panes, the Query Designer 
displays an error and then offers you two choices:

· Return to the SQL pane and edit the statement.
· Discard your changes and revert to the most recent correct version of the SQL statement.

If you return to the SQL pane and continue editing the statement that the Query Designer, the Query 
Designer dims the other panes to indicate that they no longer reflect the contents of the SQL pane.

You can also use the SQL pane to enter back-end-specific SQL statements. In that case, the Query 
Designer displays the same behavior as when it detects an error, and dims the Diagram and Grid 
panes to indicate that they do not represent the current statement. You can continue to edit the 
statement and execute it as you would any SQL statement.

Note      If you enter an SQL statement, but then make further changes to the query by changing the 
Diagram and Grid panes, the Query Designer rebuilds and redisplays the SQL statement. In some 
cases, this action results in an SQL statement that is constructed differently from the one you 
originally entered (though it will always yield the same results). This difference is particularly likely 
when you are working with search conditions that involve several clauses linked with AND and OR.

See Also
Diagram Pane

Grid Pane

Results Pane



Results Pane
The Results pane shows the results of the most recently executed query. In the Results Pane you 
can:

· View the result set for the most recently executed query in a spreadsheet-like grid.
· Edit the values in individual columns in the result set.
· Add new rows.
· Delete existing rows.

If you change the query definition (for example, add another output column to the query), the Query 
Designer dims the Results pane to indicate that it no longer reflects the current query. However, you 
can still navigate in the Results pane grid to edit, add, or delete rows.

Viewing the Result Set
When you execute a query, the Query Designer displays the result set in the Results pane grid. The 
Query Designer fetches and displays results incrementally (asynchronously) so that you can begin 
viewing data immediately and perform other tasks while the query is being executed.

The Query Designer uses these conventions when it displays data in the grid:

· Columns containing no value display the word <NULL>.
· Columns containing memo or binary data display the word <BLOB> (for “binary large object”). You 

cannot edit the contents of these types of columns.
· Columns containing long varchar-type data display only a portion of the data column; to see all of 

the data, click the cell.
· Number, currency, time, and date information is formatted according to the options set in the 

Regional Settings dialog box in the Windows Control Panel.

Navigating Through the Results Pane Grid
To see all of the result set, you can navigate through the Results pane grid.

To navigate through the Results pane grid
· Move from cell to cell using the mouse or by pressing TAB, the arrow keys, or CTRL plus the arrow

keys.
– Or –

· Use the vertical and horizontal scrollbars in the grid.
– Or –

· Right-click to display the shortcut menu, and then choose First, Last, Next, or Previous, or 
choose Go to Record to move to a specific row in the grid.

Resizing Grid Columns
If all of the data for a query does not fit on your screen, you can resize the grid columns.

To resize a grid column
· Move the mouse over the divider between grid column headers until it changes to a double-headed

arrow, and then either drag the grid column header until the column is the size you want or double-
click to auto-size the column.

Note      The width of the Results pane grid columns has no relationship to the width of the 
corresponding data columns. Resizing the Results pane grid column does not change the width of 
the data column in the table.

If the Results pane grid contains out-of-date information, you can clear it.



To clear the Results pane grid
· Right-click to display the shortcut menu, and then choose Clear.

See Also
Diagram Pane

Grid Pane

SQL Pane



Insert Into Table Dialog Box
Allows you to specify an input source to insert new rows into. This dialog box appears when you 
choose Insert Query from the Tools menu.

Dialog Box Options
Append records to table      Type or select from the list the name of the input source to add rows to. 

You can specify only one input source for the Insert query.
Note      You can change the table to insert records into in the Properties window. For details, see 
Query Tab, Properties Window.

See Also
Query Tab, Properties Window

Results Pane

SQL Pane



Update Table Dialog Box
Allows you to specify the input source to be updated. This dialog box appears if more than one input 
source is displayed in the Diagram pane when you choose Update Query from the Tools menu.

Dialog Box Options
Select the input source to update, and then choose OK.

See Also
Results Pane

SQL Pane



Delete Table Dialog Box
Allows you to specify the input source to delete rows from. This dialog box appears if more than one 
table is displayed in the Diagram pane when you choose Delete Query from the Tools menu.

Dialog Box Options
Select the input source to delete rows from, and then choose OK.

Note      A Delete query removes entire rows from the input source. If you want to clear values from 
individual data columns, use an Update query. If you want to delete columns from a table definition, or
delete the table itself, use the Database Designer (Microsoft SQL Server only).

See Also
Results Pane

SQL Pane



Define Query Parameters Dialog Box
Allows you to enter values for the parameters defined in the query. This dialog box appears when you 
execute a query that contains parameters to be filled in at runtime.

Dialog Box Options
Parameter Name      Lists the parameters defined for the query being executed. If the query contains 

named parameters, the names appear in the list. If the query contains unnamed parameters, a 
question mark appears for each parameter in the query.

Parameter Value      Enter the value for each parameter listed under Parameter Name. If you have 
executed the query before during this session of the Query Designer, the value used most recently 
appears as the default parameter value.

See Also
Parameters Tab, Properties Window



Go To Record Dialog Box
Allows you to navigate to a specific row in the Results pane. This dialog box appears when you 
choose Number … from the shortcut menu in the Result pane.

Dialog Box Options
Record      Enter the row number of the row you want to navigate to. If the query has finished fetching 

query results, the total number of rows in the result set is displayed. If you enter a number higher 
than the total number of rows in the result set, the Query Designer moves to the last row.

See Also
Results Pane



Query Tab, Properties Window
Contains options for controlling the behavior of the query you are building or modifying.

Tab Options
Query name      Displays the name for the current query. You cannot change the query name in this 

box; to assign a new name, use the Save As command from the File menu.

Set query options
Output all columns      Specifies that all columns from all tables in the query will be displayed. 

Choosing this option is the equivalent of specifying an asterisk (*) in place of individual column 
names for output.

Distinct values      Specifies that the query will filter out duplicates when it displays results. This 
option is useful when you are displaying only some of the columns from a table and those columns 
might contain duplicate values, or when the process of joining two or more tables results in 
duplicate rows in the result set. Choosing this option is the equivalent of inserting the word 
DISTINCT into the statement in the SQL pane.

Destination table      Specifies the name of the table into which you are inserting rows. This list 
appears only if you are creating an Insert Into query. Select a table name from the list.

See Also
Join Line Tab, Properties Window

Parameters Tab, Properties Window



Parameters Tab, Properties Window
Specifies options for marking parameters in the query.

To include a parameter in a query, you must mark the parameter using special characters so that the 
Query Designer does not mistake your parameter name for text data. For example, if you specify 
square brackets ( [ and ] )as parameter markers, you can enter a parameter by specifying a search 
expression such as the following:
= [last_name]
When you run the query, the Query Designer prompts you for a value, then substitutes the value you 
provide for the parameter last_name.

Tab Options
Prefix character      Specifies the character that marks the beginning of a parameter.
Suffix character      Specifies the character that marks the end of a parameter.
Escape character      Specifies a character that is used to indicate that a parameter marker character 

in a name is meant literally. For example, if you specify “%” as a parameter marker, you would not 
normally be able to include that character in a parameter name such as “% complete”. However, 
you can specify “\” as an escape character, and then use the following string as the parameter 
name:
%\% complete%

See Also
Join Line Tab, Properties Window

Query Tab, Properties Window



Join Line Tab, Properties Window
Specifies options for how tables are joined in a multi-table query.

By default, related tables are joined using an inner join that creates a result set based on rows 
containing matching information in the join fields. By setting options in the Join Line tab, you can 
specify a join based on a different operator, and you can specify an outer join.

Tab Options
Operator      Specifies the operator used to relate the join fields. To specify an operator other than 

equal (=), select it from the list. When you close the dialog box, the operator you selected will 
appear in the diamond graphic of the join line.

Include Rows
Specifies whether unmatched rows appear in the Results pane.

All rows from <table1>      Specifies that all rows from the left table appear in the output, even if there
are no corresponding matches in the right table. Columns with no matching data in the right table 
appear as null. Choosing this option is the equivalent of specifying LEFT OUTER JOIN in the SQL 
statement.

All rows from <table2>      Specifies that all rows from the right table appear in the output, even if 
there are no corresponding matches in the left table. Columns with no matching data in the left 
table appear as null. Choosing this option is the equivalent of RIGHT OUTER JOIN in the SQL 
statement.

Selecting both options is equivalent to specifying FULL OUTER JOIN in the SQL statement.

When you select an option to create an outer join, the diamond graphic in the join line changes to 
indicate that the join is a left outer, right outer, or full outer join.

Note      The words “left” and “right” do not necessarily correspond to the position of tables in the 
Diagram pane. “Left” refers to table whose name appears to the left of the keyword JOIN in the SQL 
statement, and “right” refers to the table whose name appears to the right of the JOIN keyword. If you 
move tables in the Diagram pane, you do not change which table is considered left or right.

See Also
Parameters Tab, Properties Window

Query Tab, Properties Window



Returning Query Results (Edit)
Notifies you that the Query Designer cannot save changes to the row you have edited because a 
query is still in progress. This dialog box appears when you execute a query, and then before the 
query has been completed, you edit a row in the Results pane and attempt to save it by moving to 
another row in the grid.

By default, the Query Designer waits until the query is finished before saving the row you have edited 
and moving to the requested row. To help you estimate how long you must wait, the dialog box 
displays a progress counter.

Dialog Box Options
Cancel      Choose this button to specify that you want to cancel your attempt to move to another row. 

The Query Designer returns you to the row you have edited, and you can save the changes later 
when the query is complete.

See Also
Results Pane



Returning Query Results
Notifies you that the Query Designer cannot perform the requested action because a query is still in 
progress. This dialog box appears when you execute a query, and then before the query has been 
completed, you attempt one of the following operations:

· Attempting to go to a row in the query results that has not yet been fetched.
· Inserting a new record in the Results pane.
· Deleting one or more rows in the Results pane.
· Using the Copy command to copy selected columns to the Clipboard.

Dialog Box Options
Cancel      Cancels the attempted operation and leaves you at the row you were on when you 

requested the operation.

See Also
Go To Record Dialog Box

Results Pane



Database Changes Detected
Notifies you that the data row you are editing in the Results pane is no longer current. This dialog box
appears when you attempt to save changes to a row by moving to another row in the Results pane 
and the Query Designer determines that the corresponding row in the database has changed. This 
situation occurs most often when another user has edited the row and saved the changes since you 
ran your query.

The dialog box displays a message asks how you want to proceed.

Dialog Box Options
Yes      Choose this button to specify that you want to save your changes and overwrite the changes 

made by the other user.
No      Choose this button to discard the changes you have made and fetch the most current version of

the row. The Query Designer returns you to the Results pane after rereading the row from the 
database.

Cancel      Choose this button to return to the Results pane without saving the row and without 
discarding your changes. If you choose this option, you can attempt to save the row again, or make
further changes such as matching your edits to the version of the row in the database.

Tip      To see the most current version of the row without discarding your changes, run a second 
query against the data you are editing.

See Also
Results Pane



SQL Syntax Errors Encountered Message
Notifies you that the statement in the SQL pane contains one or more syntax errors.



Query Definitions Differ Dialog Box
Notifies you that the SQL statement in the SQL pane cannot be represented in the Diagram and Grid
panes because it contains:

· a SQL command that the Query Designer cannot execute.
· a SQL command supported only by the data source you are using.
· one or more syntax errors.

This dialog box appears when you have entered such a statement in the SQL pane and you switch to 
another pane or execute the query.

Note      The Query Definitions Differ dialog box does not appear if you have hidden the Diagram and 
Grid panes.

The dialog box displays a message indicating why the SQL statement cannot be represented, and 
asks how you want to proceed.

Dialog Box Options
Yes      Choose this button to specify that you want to accept the SQL statement, either to edit it further

or to execute it. If you accept the statement, the Query Designer dims the Diagram and Grid 
panes to indicate that they do not represent the statement. 
Note      If the statement is not supported by the Query Designer but is correct, you can execute it 
even though it cannot be represented in the Diagram and Grid panes. For example, if you enter an
INSERT statement that includes a VALUES clause, the statement can be executed but not 
represented in the other panes.

No      Choose this button to discard the changes in the SQL pane and revert to the most recent SQL 
statement that can be represented in the Diagram and SQL panes.




